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The SAFE object types cormespond to the following DXF element types.

SAFE Objects DXF/DWG Elements

Foint Objects Points

Line Objects 30 Paolylines

Area Objects 3Dfaces and 3- or 4-sided closed polylines
Design Strips Polylines

Design Strip Widths Polygons

Tendon Objects 3D Polylines

(Grid Lines) .cul aSs blas 5Lo o)y sl Architectural Plan a5

b jolic gy (1Y

lewl o] cdg oV awsl asls slahi polic puwy 4 5L Jowe ST
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@hm)..phc'ﬁm; (\A

oS (50 o |y (o yolie

(9o 2 g 5l abi O oo it mhaw jate vy sl

Quick Draw Areas Around Points

6

i 4aSS (] ]

[ _E_Ej Quick Draw Areas Around Points Ii'ihj ]
Type of Object Slab
Shape of Object Rectangular Slab
Property Footing - 600 -
X Dimension [m] 1
Y Dimension [m] 1
Trim At Slab Edges Yes

el dbe 05800 5B o ey Sl Ghg) o)
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Edit > Edit Areas > Expand /Shrink Areas
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Quick Draw Areas Around Points
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Sl SoS eaalie |, S gla s o S RUN LSS, o o >hb Jle s 5l L8 098 o

D903 a3 |y (bl ol 0 S Aol g o Slal s @

alol suos > o Model Explorer s a5 ¢S o saslive (>lhb Jlg 10 puy 5l e
b sla )l slean S ule slacalld 4 cé, Set Display Option cwd « ol o
58 Jub et b Jlab ,
s oS oo o Bl ] S ol 1 hb g dsain aealssy S
Edit > Add/Edit Design Strip > Edit Strip Width
st 2 ool & (bbb sl el welas oy g

Design > Slab Design Overwrites > Strip Based
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Dy g EAIL (g5 a5 05 00 @S g0 Sl | (2 15 Canns 90 51 (So 05 58y
Align Points/Lines/Edges ... (Ctrl+ Shift + M)

980 Sk Sz oz S5 )
[ 389 Align Points/Lines/Edges | P[]

Edit Options for Selected Objects
i@ Align Points to ¥Ordinate in Curent Coord. System o m

() Align Points to Y-Ordinate in Curent Coord. System

() Mlign Poirts to Nearest Selected Line/Edge

b S G i ) 4SS e 5 S Sl 2k lg 055 05 sl 4 STV

P9 s
224 Align Points/Lines/Edges Ii'ihj

Edit Options for Selected Objects

(") Trm Line/Edge/Tendon/Stip Objects
@ BExtend Line/Edge./Tendon./Strip Objects
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354 Design Preferences B |

Code | Min. Cover Slabs | Min, Cover Beams | PIT Stress Check

Mon-Prestressed Reirforcement

Clear Cover Top {mm) 0
Clear Cover Bottom {mm) H0
Prefemed Bar Size 16 w7
Inner Slab Rebar Layer Layer B
Post-Tensioning
CG5 of Tendon Top (mm) 25
CG5 of Tendon for Bottom of Bxderior Bay {mm) 40

CG5 of Tendon for Bottom of Interor Bay {mm) 25
Minimum Reinforzing

Slab Type for Minimum Reinforcing Two Way

| Reset Tab Defauts |
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Y axiao  0-F-9 Jgo
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_:;i Load Case Data - Nonlinear Static
Load Case Nams Load Case Data Notes Load Case Type
CO5-NL [ Modify/Show Notes... ’5taﬁ|:: v] [ Design... ]
Initial Conditions Analysis Type
@ Zero Initial Conditions - Start from Unstressed State 7 Linear

Loads Applied

Load Name

» [DEAD

[LIvE

[ExN

* |

Scale Factor
12

1.

1.

@ Monlinear (Alow Uplft)
~) Nonlinear {Cracked)
) Nonlinear {Long Term Cracked)

Uplift Solution Control

Force Converngence Tolerance (Relative)

0.00001

oK | [ cancal |

b slls b

CMP)J“}_»S)_».U."P‘)ég»‘_u.:‘uj.oﬁy5Xgae‘>b)§iﬁn6l.®o)&w6)j)‘)3w)4uﬁ?

Design > Slab Design Overwrites > Strip Based
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284 Strip Based Slab Desig

n Overwrites

General
Strip Layer
Strip Design Type

[ lgnore PT

Material
Rebar Material

Cover

Design This Strip

") From Preferences

@ Specified to Center of Steel

Top Caover | mm
Bottom Cover an mm
Live Load Reduction
Feduced Live Load Factor 'I_ 14

A

[Cnlumn Stp

When Designing This Strip

Alll

-
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Assign > Load Data > Point Loads ...
D9 0 b slo iy

Size of Load for Punching Shear
¥ Dimension 400 mim

Y Dimension 400 mm
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COptions
@ Addto Bxdsting Loads {-——
Replace Existing Loads

Delete Existing Loads
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Run > Automatic Slab Mesh Options
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F10) j5ims jlre by (55 4 glaSe (o (i Camd ioles sy

Design > Show Punching Shear Design

WS el 42 Glisn S 2l 1y Jalos gl 4SSl g0,

Display > Punching Shear Overwrites

3,5 Ol ) o > 55 0 Location Type cuid o

00,6 Ul |y mls aS 1> aiS o Job ol ;550 Ll Lol oy 1) RUN 4655 0,Lgd (s

2o

e |y (Slhpw el g usS o JiuS |y badls plod Sogs 435 5l oolatnl &0 j0 auliy

i ConBge oo el 4,0l a8 Ll s ]

Bl b Slalows asmas aigai 4

[ 324 Design Details - [ D[S |
File  View
Combination ACI 318-08 Punching Shear Check & Design i
DCONUZ -

ltems to Display
V| Geometric Properties
| Column Perimeter Figure

| Column Punching Check

Done

Geometric Properties

Combination = DCOMUZ
Paint Label =9

Column Shape = Rectangular
Colurmn Location = Corner
Global ¥-Coordinate = 0 m
Global ¥-Coordinate =0

Load Punching Check

Avy. Eff. Slab Thickness = 567 mm

Eff. Punching Perimeter = 5167.2 mm

Cover =33 mm

Conc. Comp. Strength = 30 N/mm2
Reinforcerment Ratio = 0.0000

Section Inertia 22 = 2.076E+12 mmd

Section Inertia 133 = 2.076E+12 mmd

Section Inertia 123 = 1.222E+12 mmd

Shear Force =-1093.544 kN

MWoment Mu2 = 266.2365 kN-m

Moment Mu3= 2662368 kN-m

Max Design Shear Stress = 0.775925 N/mm2
Conc. Shear Stress Capacity = 1.364399 N/rmm2
Punching Shear Ratio = 0.57

m

Column Punching Perimeter

i o Sl 90

Y4
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38 Choose Tables for Display

Edit

=[] MODEL DEFINITION [0 of 41 tables selected)

------ O System Data

------ [0 Geometric Data

------ O Definitions

------ O Assignments

------ O Design Data

=[] ANALYSIS RESULTS (0 of 13 tables selected)

------ [ Analysis Result Summaries

------ O Analysis Result Enveloping Summanes

------ O Nodal Results

------ [0 Element Results

------ O Structure Result Data

= DESIGN RESULTS (1 of 4 tables selected)

------ O Design Result Summanes

-E Concrete Design

-8 Concrete Siab Resuls

-------- [ Table: Concrete Slab Design 01 - Flexural And Shear Data
- (] Table: Concrete Slab Design 02 - Punching Shear Data

A oo Al sloj> 0 S caslin I &b oh e Jeu

O YO 090> (6 e gilw Cuad gl | 4y 00gllls (5, 0 kz )0 K GFee S igoga> das
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254 Punching Shear Specified Perimeter

RS

Punching Shear Specified Perimeter

Motes

location.

Seqment L egend

Point ar X—F["?;gtrd YETM Point Radius ~ Segment |s Eﬁﬁqular
Segment e = (i) Mull Selected

1 -1000 -1000 0 MNo

2 1000 -1000 0 MNo

3 1000 1000 0 MNo

4 -1000 1000 0 No -

8
XY {mm}) |

1. Segment 1is from point 1to point 2, etc. Last segment is from poirt n to point 1.

2. The specified perimeter must be a polygon defined using at least three points.
The polygon edges can not cross each other.

3. The Xand Y coordinates are measured relative to the selected point object

4. When the selected point object is at the end of a column object the X and ¥
coordinates are measured in the column local 2 and 3 axes directions,
respectively (bottom column contrals when both top and bottom column exdst). In
all other cases the offsets are measured in the global X and Y directions.

[ Reset to Default ]

2,5 0)ly o9 ) laone S8 ()l 0 06l 0

£

pgal (el (imen g




SAZE1 18.coM

224 Punching Shear Design Overwrites I. ? ﬂh]

Punching Shear Design Cvenwrite Options

Check Punching Shear [Prcgmm Determined v]

Location Type (See Tooltip) [Aum v]

Perimeter | Specified Pesimater | [ speciy.. |

Effective Depth [Aum
Coluran Plan Shawing Location Type

Edge 3

|Jsg

Corner 4 Corner 3

Ope

3
Rei 2
Edge 4 Edge 2

Rei

Rei

R Corner 1 Edge 1 Corner 2

) I 1L

= Maote: Edge and cormer numbers are

bazed on column local axes.
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( 4
0.2654(2+ 7 Jr
c

Vp = miny 0.265¢(2 + abSd)‘/E i [kgf —cm ]
0

L 1.06pf!
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11.11.2.1 — For nonprestressed slabs and footings,
V. shall be the smallest of (a), (b), and (c):

(a) (11-31)

V, = 0171+ %]xﬁbod

where f#is the ratio of long side to short side of the
column, concentrated load or reaction area;

(b) v, = o.osa(ude+ 2)xﬁbod
o

(11-32)

where ag is 40 for interior columns, 30 for edge
columns, 20 for corner columns; and

(11-33)

| (c) V, = 0332 [f/ b,d

R11.11.2.1 — For square columns, the shear stress due to
ultimate loads in slabs subjected to bending in two directions is
limited to D.SJZﬁ . However, tests!161 have indicated
that the value of 0.33/1,\/5 is unconservative when the ratio
f of the lengths of the long and short sides of a rectangular
column or loaded area is larger than 2.0. In such cases, the
actual shear stress on the critical section at punching shear
failure varies from a maximum of about 0.331 + around
the corners of the column or loaded area,

down to
0.174 [f/ orless along the long sides between the two end
1162 indicate that v. decreases as the

sections. Other tests
ratio b, /d increases. Equations (11-31) and (11-32) were devel-
oped to account for these two effects. The words “interior,”
“edge.” and “corner columns™ in 11.11.2.1(b) refer to critical
sections with four, three, and two sides, respectively.

For shapes other than rectangular, f is taken to be the ratio
of the longest overall dimension of the effective loaded area
to the largest overall perpendicular dimension of the
effective loaded area. as illustrated for an L-shaped reaction
area in Fig. R11.11.2. The effective loaded area is that area
totally enclosing the actual loaded area, for which the
perimeter is a minimum.
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(ACI11.11.2.1)

where, ﬁ is the ratio of the maximum to the minimum dimensions of the criti-
cal section. D, is the perimeter of the critical section, and «, is a scale factor
based on the location of the critical section.

40
30
20

for interior columns,

for edge columns, and (ACI11.11.2.1)

for corner columns.
A limit is imposed on the value of \/ch as:

JF'e <100 (ACI11.1.2)
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2.6.1.3  Minimum and Maximum Slab Reinforcement
The minimum flexural tension reinforcement required for each direction of a
slab is given by the following limits (ACI 7.12.2):
A, i, = 0.0020 bh for f, = 40 ksi or 50 ksi (ACI7.12.2.1(a))
A, . = 0.0018 bh for f, = 60 ksi (ACI 7.12.2.1(b))
0.0018 x60000
cmin = - bh for f, > 60 ksi (ACI7.12.2.1(c))
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Number | Load Combination

K01 1.4DL

K02 1.2DL + 1.6LL

K03 1.2DL + 1.0LL + 1.0EX

K04 1.2DL + 1.0LL — 1.0EX

K05 0.9DL + 1.0EX
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K06 09DL — 1.0EX

K07 1.2DL + 1.0LL + 1.0EY

K08 1.2DL + 1.0LL — 1.0EY

K09 0.9DL + 1.0EY

K10: 0.9DL — 1.0EY
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tComnd
Display > Table ...
omd
Analysis > Wall Output > Wall Forces > Pier Forces
9
Optians
W Selection Only
9
Caod 4

Load Cazes [Model Def.]

Select Load Caszes... |
3 of 3 Load: Selected

Load Cazes/Combos [Fesultz]

Select Cazes/Combosz... |
3 of 90 Loads Selected

Modify/Show Dptions... |
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Edit  View

| Pier Forzes

Vi M2 M3
-1869.80 0.000 3745172.520 0.000
-1869.80 0.000 -1860237.812 0.000

19.43 0.000 -38064 512 0.000
19.43 0.000 19333.135 0.000
0.00 1762543114 0.000 1118960172.3
0.00 1762543114 0.000 Z313208942.0
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Sz L pylie plu 45 39800 Jle ol amio I )5 S 5l 508 by b oyl

fdonll 59

(oS JysS b 1y aen ) (osS o J S 1) 5b cuS 5 (g 90

1 |1.2DL + 1.6LL
2 |1.2DL+1.0LL + 1.0EQ

(el Hlas 5550 DOttOM p33li0) : sl > (sl 5

1.2DL + 1.6LL = (1.2)(772030) + (1.6)(116489) = 1112818 N
(e S 85 s g
1pgd S (sl
o 5l (S L

1.2DL + 1.0LL = (1.2)(772030) + (1.0)(116489) = 1042.9 kN
o 311, S s

1.0EQ = 2313208942 N.mm = 2313.2 kN.m
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465

N
§
\
N
\
\
%
\

464

465 2350 465

3280

N &
O
o

= T =465 mm
930
b, = 2350 + 2 XT: 3280 mm
930
b, :200+2XT: 1130m

139 oo dnmlire johat| € gl by lao? 4
by = 2(3280 + 1130) = 8820 mm

A, = byd = 8820 x 930 = 8202600 mm?

1 1

T + (%),/bl/bz T + (%)w/3280/1130

= 0.468

Yr

Yo =1—y;=1—0483 = 0.532

(FAF amio pgs alz) 305 Byias 258 LS Luls, Lolul
Je

[b;d(b; + 3b,) + d3]

Wl =

Cc

[3280 x 930(3280 + 3 x 1130) + 9303] = 70.502 x 108 mm?

W =
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o= e YoMuc
A T

1042.9 x 10® 0.532 x 2313 x 10°

- = 0127 4+ 0.174 = 0.301 MP
Vur = o0 %106 T 70.502 x 10° + a

cwd [N =mm] 5 Ly, 9>

@ = 0.75) 1 ooy conglio ol oy

(@s = 40) « sl ooz

A =1.0) ¢ Jsoro

B = 2350/200 = 11.75) ¢ s slan b s5im lbios gl e &1 Job cos

(¢ ¢ 0.75
s+ —)/1 fe
NI (14 75)(1 021
0.75 40 x 930
Vp = min{ i(2 + )A\/f_ =min{—> 2 +—55 )(1.00vV21 ; [MPa]
\/f_c (0.75)(1.0)v21
\ 3 \ 3
Ll plp«ad b &y io» a0

0.670
vp = miny 1.74 = 0.67 MPa

1.145

v 0.30
Critical Ratio = —2%% — ——_ — 0.44
ve  0.67
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ACI 318-08 Punching Shear Check & Design

Geometric Properties

Combination = 101

Paint Label =2

Column Shape = Rectangular
Colurmn Location = Interior
Global ¥-Coordinate = 5.5 m
Global ¥-Coordinate =0 m

Load Punching Check

Awy. Eff. Slab Thickness = 930 mm

Eff. Funching Perimeter = 8820 mm

Cover = B3 mm

Conc. Comp. Strength = 21 Bmm?2
Reinforcement Ratio = 0.0000

Section Inertia 122 = 2.323E+12 mmd
Section Inertia 133 = 1.156E+13 mm4
Section Inertia 123 =0 mmd

Shear Force =-1003.986 kM

boment Mu2 = -0.0183 kMN-m

Moment Mu3= 12258603 kN-m

Max Design Shear Stress = 0.296528 N/mm2
Conc. Shear Stress Capacity = 0.667921 MYmm?2
Punching Shear Ratio =0.44

Column Punching Perimeter

el GlSG lail]y) b gews Sl

SAFE 4 SAP jlo0ls Just R

1S s 0l 1) cdbas ol (YP0ul>) odiny g

CouiSS ou2lys o0 4

oS Lol S laws s Jiml SAFE a0 pol don Jio |, Jubos guls SAP2000 a5 oils oo
sn Judiar |y Wil Jarll S 5 wno g JUH 1y st oy 55 ) ai quu lo st oo Blo
3o el i 5l 4 lg,y S ool | SAFE Sy oed BB LL o, SIS L puoles o a0

Yo

el 00 o0l oy Jado Fel= 0 Jolye



SAZE1 18.coM

b oo 5o Excel Jble s a 15 ol o
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Dy peel, 5 o ETABS

J=1
oS0 b ) SAP Jl8le
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imsse e 2l mnS o0 7o
File > Export > SAFE.F2K

oS o (Se oy 5l

Elevation of Objects to Export ||:|

(" Export Floor Loads Only
(+ Ewpart Floar Loads and Loads fram Above

Load Cazes to Export | Select Lazes

Cancel |

i S 2 sl
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Select Load CaS_ -

— Select

Clear 41 |

5 - |

Notepad ,)sle 5 5l eoliiwl b .ousS oo 5L 15 0o adgs L6

), ol oaal oo paste slaps wb 45 e 450) Excel 31 4iS oo (oS ) don

s myes L EAD LSS am auiee |, Use Text Import Wizard ... &jls 5 wojee

(Ngw oo AlalS slacl aS ol loiin
5" 10 10 UX UY UZ
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0 Use Text Import Wizard... Sl
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heetl . Sheet2 . Sheet3 .~ ¥#1

im9sss 25 o3l 4 SAP J38le 5 s
Display > Show Tables ...
s 592

T—rT L T

EI. AMALYSIS RESULTS [1 of 16 tables selected]
EI. Joint Dutput
P H:a O Dizplacements

EI E Reactions

: ¢ o[ Table: Joint Reactions

- &0 Joint Masses

TRIPUM: L, 54.».».” 9

— Load Caszes [Fesultsz)

Select Load Cazes.. |
1 aof 37 Selected

Dy bepl 5l (S oS o0 Sl ) L g9 G Laid

Yy



SAZE1 18.coM

Dead, Live, EX,EY
edigS o5l gy ole aSI L N AST eadigs g 02,10 puleB oo 4S g 095 s (S5 I8
wsse |, OK 3sSs sl
Comnd )0
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